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About This Copy of the Manual 
 
This is revision 0 of the manual to BlueVoda ver. 12, last updated on November 7, 2011. 
 
 
Using This Manual 
 
Throughout the manual, there will be cross-references to other parts of the manual. These will generally 
be in the form of a dark gray page number—for instance, Chapter 4 is on page 54 (clicking the number 
there will go directly to page 53). The Table of Contents is also cross-referenced; click on the section 
you're looking for to travel there instantly. Alternatively, the PDF’s bookmarks can be used to navigate 
quickly through the manual. 
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About BlueVoda 
 
I. Overview 
 
BlueVoda is the World's most comprehensive and powerful website builder for personal computers and 
offers by far the most complete website building experience available for home use. 
 
BlueVoda’s sophisticated HTML generation engine means that you can add just about any web-element, 
and therefore just about any functionality, to the web pages that you create in any location. 
Subsequently you have full control to edit, resize and move any web element at any time in any way. 
 
BlueVoda is a tool that can be used to create a website that is static or dynamic with incredible results. 
 
 
II. What BlueVoda Includes 
 
BlueVoda The website builder software – This is where the magic happens! 
 
BlueFTP BlueVoda's built-in FTP client. Used to facilitate the publishing of your web-pages to the 

Internet via VodaHost's servers. 
 
Hosting A desktop link to the VodaHost site; a VodaHost account is required to publish web-

pages built with the BlueVoda website builder. 
 
SEO A desktop link to the VodaHits site; here you can optimize your website so that they can 

be found easier by the search Engines. Choose VodaHits for the World’s greatest Search 
Engine Optimization packages. 
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Forward: 
How to Plan your Website & Getting 
Started on your First Web Page 
 
Congratulations on your download of BlueVoda and welcome to VodaHost! 
 
VodaHost is committed to helping you construct your first web page and getting you online as quickly as 
possible. Creating your first web page can be a daunting task: “Where do I get started?”, “What should I 
do?” Fortunately it doesn't have to be this way; creating a web page is a fun and rewarding experience if 
you follow a few simple guidelines, which we have outlined for you here. 
 
The first thing that you should do when preparing to construct your first web page is to define it. What 
do you want your web page to do? Don't just start constructing your page; really think hard about it. You 
should consider how you want it to look and what information you want to provide to your prospective 
customers in order to persuade them to buy your products or services rather than going elsewhere. 
 
Be sure that you organize your pages well; think of your Home Page like the Table of Contents page in a 
book - it's there so that your customers know where to go in your site for their particular needs, or just 
to familiarize themselves with your products. When defining your site you should certainly do your 
homework. Always visit your competitions web site to see how they have organized their site, so you 
can make yours better, whether it is just including more information about your product, or simply 
improving the design of your site. 
 
Now that you've given some serious thought to how you want your web site to look and what you want 
to include in it, you need to decide on a name for it. There are various approaches to finding the right 
name for your web site; the first is to make the name logical (for instance, abc’s web site is abc.com). 
Another approach is to make the name memorable so that your customers can type it in without 
thought, the name does not have to be descriptive of the product you sell, for example amazon.com 
sells books. You should keep the name as short as possible too, so that it's easy for your customers to 
type the URL into the text field. 
 
With your web page named and thought given to how you want it to look, here are some pointers for 
building your site. If you have pictures on your web page go over them first with a photo editing 
program, like PIXresizer so that the customer’s browser does not have to crunch them. This will also 
speed up the download speed of your page so that the customer can view quickly without having to wait 
for large picture files to be rendered in the browser. 
 
One of the most aggravating things for people surfing the web are pages that take a long time to 
download. All those fancy graphics will do you no good if, instead of waiting for the page to download, 
the viewer closes his browser and goes elsewhere. Consider going light on the pictures and heavy on the 
text content. 
 
You should also put some serious thought into what color fonts you are going to use as well as the 
background color. If in doubt, remember that a white background with black text has been successful for 
thousands of years! 

http://www.vodahost.com/
http://www.bluevoda.com/
http://www.vodahost.com/
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Your website should also be easy to navigate, all your links should be obvious to the viewer, and should 
be self explanatory or have information about where the link will take them. Try to keep the number of 
links you have low, the viewer does not want to spend a lot of time waiting for links to download, 
chances are, like you, he is pretty busy! Further, always link back to your homepage in order to make 
navigating your web page easier for your potential customers. 
 
Now, before you even open up BlueVoda, you should construct your web site on paper. Decide the 
number of pages you want to have inside of your site, and determine logical titles for them. Think of any 
pictures that you might want to put on each page and where you are going to put them in order to be 
most effective. You should plan out your hyperlinks now, as it will make keeping track of them later a lot 
easier and save you time trying to figure out why they are not working properly. Decide where you want 
to put any buttons that you might create for hyperlinks as well. Lastly write out any information content 
you will be putting onto your web page in Microsoft Word first so you can detect any spelling errors you 
might have made. You can cut and paste parts into BlueVoda later. 
 
Lastly, familiarize yourself with BlueVoda before you start using it. Watch the Video Tutorials that we 
offer so that you have an idea of what you can do with BlueVoda. Further, you should make a practice 
page first so that you can get a feel for BlueVoda and some experience using it before you start 
constructing a page which you will publish on the World Wide Web. 
 
It takes two to three months to learn how to use DreamWeaver and at least a month to learn FrontPage, 
while you can learn BlueVoda in hours. Practice adding and deleting text, pictures, and hyperlinks until 
you can do these actions with ease. 
 
Building a web site with BlueVoda is easy if you follow the above steps. The most important part of the 
construction process actually takes place before you open BlueVoda. Think of constructing your web site 
like taking a test back in school, those who prepared before the test probably did better than those who 
just went in without even opening their books. 
 
So be sure to prepare before you start, think of the content you want to put in, think about your links, 
think about your web site’s name, draw up an outline on paper before you start constructing the page 
and most importantly WATCH THE TUTORIALS! 
 
In a nutshell: 

“Plan Your Work and Work Your Plan” 
Best of luck! 
 
Always at your service, 
 
Brad Costello 
VodaHost 
Your Website People! 
 
 
 

http://www.vodahost.com/
http://www.vodahost.com/web-hosting-helpcenter/video-tutorials/bluevoda-tutorials/
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Installing and Configuring BlueVoda 
 
I. Downloading the Installer 
 
BlueVoda's installer is down-loadable from the 
BlueVoda home-page at 
http://www.bluevoda.com/. To download the 
latest version of BlueVoda, visit the BlueVoda 
website, enter your first name and email 
addresses where prompted and follow the 
procedure outlined in the email that you receive. 
Depending on your choice, the file you will 
download will either be called setup.exe or 
setup.zip 
 
 
II. Unpacking the Installer (Optional) 
 
If you have downloaded the zipped version of the installer you should run your favorite unzipping utility 
(WinZip, WinRar, IzArc etc.) on it to unpack the archive to a location of your choice. 
 
If you require an additional tool for unzipping, you can try IZArc which is a great freeware utility for 
zipping and unzipping files. 
 
To unzip a zipped file, right click on it and select “Extract Here”. 
 
 
III. Running the Installer 
 
Double-click on the setup.exe file to run the installer. 
 
You may be asked if you trust the program – you should say you do, and Windows User Account Control 
(UAC) may ask again if you wish to open the file. 
 
The BlueVoda Website Builder Setup dialogue box opens up; exit any Windows programs that might be 
running and hit [ Next > ] 
 
Select where you would like to install BlueVoda. Unless you have any specific requirements, it is 
recommended that you can leave it as it is. 
 
Select your shortcut folder and press [ Next > ] 
 
To proceed with the installation, press [ Next > ] 
 
Wait while BlueVoda installs... 
 

http://www.vodahost.com/
http://www.bluevoda.com/
http://www.izarc.org/
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IV. Launching BlueVoda 
 
You can either launch BlueVoda from the Desktop shortcut that was created or from the Start menu 
entry. Double-Click the desktop icon or single click the start menu entry. 
 
 
V. Getting help and support 
 
Equally, independently of BlueVoda you can visit http://www.vodasupport.com/ or send an email 
support@vodasupport.com  
 
In addition you can participate in the VodaTalk community forum where you will find many website 
building experts who are ready to answer any questions you may have about the processes and 
techniques that lie behind building the best websites. 
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Initial Website Building Setup 
 
When you launch the BlueVoda website builder, you are presented with a list of three options: 
 

 
 
Open A New Blank Page: Opens the BlueVoda website builder with a blank workspace. Start here 

if you haven't used BlueVoda before to get started building a fantastic 
website from scratch. 

 
Open An Existing Page: Opens the BlueVoda website builder and presents you with the Open 

dialog, which allows you to continue working on a .bvp web page file 
that you had previously saved. 

 
Watch The Video Tutorials: Opens the BlueVoda website builder as well as your default web 

browser (e.g. Internet Explorer, Firefox, Chrome, etc.) and delivers you 
to an index of BlueVoda video tutorials at the VodaHost website. We 
recommend you watch these tutorials thoroughly before you begin to 
use the software, to make yourself more accustomed to the work-flow. 

 

 

http://www.vodahost.com/
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The BlueVoda work-space has many menus and toolbars. You can drag any and all toolbars to wherever 
you want them within the BlueVoda workspace. You also have full control over the menu and toolbar 
entries by using the View > Customize... selection from the main BlueVoda Menubar. 
 
Many of the options that are available to you via the BlueVoda menu bar are also available to you vial 
the BlueVoda tool bars. This manual shows you both ways to accomplish each task using both the menu 
system and the toolbar buttons that you can use to accomplish the same task. 
 
Every object that you add to the BlueVoda work-space (be it via the menu system or from a toolbar 
button) can be moved around the work-space to a location of your choice, can be resized and can also 
be configured. 
 
You're now ready to get started. Happy website building! 
 
Again, we wish you the best of luck! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.vodahost.com/
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BlueVoda's File Menu 
 
The File menu in BlueVoda is where you will usually begin working 
with BlueVoda. The File menu gives you many options: It creates new 
files for you to work on or opens files that you have saved. It is from 
here that you can manage your sessions of working with the BlueVoda 
website builder. 
 
New Page 
 

Blank Page (Ctrl + N)   Start working on a brand new 
web-page from a fresh 
workspace. This option is also 
available to you using the New 
button on the BlueVoda 
toolbar. 

 
Clone Page  Begin working on a duplicate of 

a web page that has already been created. When you click it a 
Dialogue will open and request the path to the file that you wish 
to clone. 

 
From Template (Ctrl + F) Start working on a new page based on a template that you have 

either downloaded or have created yourself. You can download 
templates for the BlueVoda website builder from the following 
URLs: 

 
http://www.vodahosttemplates.com/ and 
http://www.vodahost.com/web-hosting-image-library/ 

 
From Existing HTML page  Start working on a new website based on a web page that 

already exists. When you click this button, the Import HTML 
Page dialogue will open. Here, either choose a Local HTML file 
(on your own computer) or a remote file. You can also have the 
option to select link from Internet Explorer Favorites or Browse 
for a file on your local computer. 

 
Open Page (Ctrl + O)  Open a .bvp file that you had previously to continue working on 

it. 
 
Close Page Closes the current page that you are working on. Before the 

page closes, you will be prompted to Save any or all changes to 
the web page you are working on. 

 
Save Page (Ctrl + S)   Saves your active document under the name that you have 

assigned for it. If you are saving the web page for the first time, 

http://www.vodahost.com/
http://www.vodahosttemplates.com/
http://www.vodahost.com/web-hosting-image-library/
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you will be prompted to assign a name to the file you are 
saving. Otherwise, saving will save the page with the filename 
that you have already assigned it with a .bvp extension. 

 
Save Page As... (Ctrl + Shift + S) Saves your active document and requests you to assign a name 

to it. Use this feature to change the filename of the page you 
are working on or to save the file with a different filename. 

 
Save as Template... (Ctrl + T) Saves your active document as a template, that you can open 

and add new content to as and when you require and use as a 
template for a new page. 

 
Preview in Browser... 
 

Default Browser  Previews your active page in the web browser that you have 
selected as default for your system (e.g. Internet Explorer, 
Firefox, etc.) 

 
Edit Browser List...  Edits your list of browsers 

 
Publish     Publishes your active web page to the Internet. 
 
Print...      Prints your active web-page 
 
Print Preview     Shows how your pages will look when printed 
 
Print Setup...     Select your options for printing your document 
 
Recent Files Recent files allow you to open pages that you have recently 

worked on in BlueVoda, rather than going through the File > 
Open web page route. 

 
You will be presented with the files that you opened most 
recently and you can just click on one to open it up. 

 
     e.g. 1 C:\Users\...\links.bvp 
       2 C:\Users\...\downloads.bvp 
      3 C:\Users\...\contact.bvp 
      4 C:\Users\...\blog.bvp 
 
Exit Closes the BlueVoda website builder. You will be prompted to 

save any pages that you have changed without saving before 
you quit the program. 

 
 
 
 

http://www.vodahost.com/
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TUTORIAL: 
An Introduction to BlueVoda (Summary) 
CLICK HERE for Video Tutorial 
 

• To create a new website page, simply click the New button in the top left hand corner (or select 
File > New Page > Blank Page or key Ctrl + N on your keyboard). 
 

• To open an existing website page, click the Open button (or choose File > Open Page... or key 
Ctrl + O on your keyboard). 
 

• To Save the web-page you are working on, click on the Save button (or choose File > Save 
Page... or key Ctrl + S). 
 

• Cut, Copy and Paste all work in the same as they do for Microsoft Word (you can find these 
menu items in the Edit menu). 
 

• Click the Text button to add text to your website (or select Insert > MenuItem from the 
Menubar). 
 

• Click the Image button to add an image (or select Insert > Image from the Menubar). 
 

• Click the Shape button to add a shape (or select Insert > Shape from the Menubar). 
 

• Click the Table button to create a table (or select Table > Insert Table... from the Menubar). 
 

• The Formatting toolbar lets you control all your text. 
 

• The Forms toolbar allows you to build an email form within seconds. 
 

• The toolbar on the left allows you to add various external elements such as Flash, QuickTime, 
Plugins as well as many more features. 
 

• All the buttoned tasks can also be accomplished via the drop-down Menubar. 
 
 

TUTORIAL: 
Naming Pages in BlueVoda 
CLICK HERE for Video Tutorial 
 
Once you have built your web-page as you want it, click the Save Button (or select File > Save, or Ctrl+S) 
to save your page. 
 
It’s very important that you have an Index page for your site; this is what your browser looks for when 
loading a domain from the Internet and so it is important that you have created an index page. 
 

http://www.vodahost.com/
http://www.vodahost.com/vodatalk/bluevoda-general-issues/9303-introduction-bluevodas-basic-functions.html
http://www.vodahost.com/vodatalk/saving-naming-previewing-publishing/66-a.html
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You should always save your home page as index.bvp – note that “index” should all be lower case. 
 
If the page you are saving isn't the landing page (or home page) for your website, pick a name for it and 
enter it as the file name in the Save Page As dialogue box that pops-up. At this point you should be 
saving your pages in the .bvp format (NOT .htm or .html – BlueVoda automatically makes this 
conversion when you preview your web page with a view to publishing it) 
 
A few tips when you are naming your pages: 
 

• Make your page names as short as possible – you'll be able to manage them better and this will 
help your visitors with entering the URL in the event they are manually typing the address. 
 

• Your page names should make sense and should be content specific. about.html makes a lot 
more sense than 1234.html, for instance. 
 

• DO NOT use spaces in your page names; use a hyphen ( - ) or an underscore ( _ ) to separate 
words in your page name. 

 
Also, DO NOT use any special characters like apostrophes (') quotation marks(“), dollar signs ($) etc. You 
must stick to numbers, letters and if required hyphens and underscores. Your web browser cannot 
interpret any special characters. 
 
When naming your websites pages: 
 

1. Name your Home Page “index”. DO NOT name your home page "home". 
 

2. Do not use capital or "upper case" letters. Do not name your index page "Index" with a capital 
"I".... use only lower case letters. Do not name any of your pages with capital letters. 
 
Do not use capital letters at all in Page Names. 
 
Do not use capital letters in any of your Hyperlinks. 
 

3. Keep the name of other pages as short as possible. 
 

4. Use underscores ("_") or hyphens ("-") to connect words. For example, do not save a page as 
"contact us," you must save it as "contact_us." If you had a page called "new products," you 
would save it as "new_products" or with a hyphen as "new-products"...  ALWAYS use 
underscores or hyphens to connect multiple words in page names. 
 
Do not allow any blank spaces between words! 
 
Do not use any symbols ($, &, +, *, etc.) other than an underscore or hyphen between words 
when creating Page Names or Hyperlinks. 
 

5. DO NOT add .html or .htm extensions to your pages. BlueVoda adds .html automatically when 
you publish your page. 

http://www.vodahost.com/
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TUTORIAL: 
Setting Page Properties in BlueVoda 
CLICK HERE for Video Tutorial 
 
To begin configuring the properties of your web page you can right click anywhere on the workspace 
and select: Page Properties... 
 
The first page property that you should set is the title page for your website. This is what your visitors 
will see in the title-bar of their browser and will also be displayed in Search Engine searches. 
 
Decide on a page width and height (a width of about 800 pixels (px) is normal; height up to you), as well 
as the default font face and size. 
 
Typically, you should leave the file extension as html 
 
Unless you have any specific need to have a different character set, leave the default setting as it is 
(ISO-8859-1) 
 
If you do not select Center in Browser, then the page will be aligned to the left in your visitor’s browser 
as opposed to being centered in the middle of the screen. 
 
If you wish, you can add an image to the page background. 
 
You can set a default color for your text. 
 
You can also set default colors for your hyperlinks. 
 
You can even set a sound file that will play on page load. 
 
Meta-tags:  Keywords – Separated by commas. These will live in the <head> section of your 

website page and will work towards benefiting your search engine ranking with 
search engines that use keywords in their ranking algorithms. 

 
Page Description: Enter a page description of around 25 words (or 160 characters) – This helps you 

with Search Engine Optimization with search engines that look for <meta> tags. 
 
Scrollbars: Here you can set custom colors for the various parts of the scroll bar. For 

instance, let’s change the scrollbar's face color. You will see a preview of the 
result for whatever changes you make. 

 
Page Transitions: You can set a page transition that will occur when a visitor enters or exits your 

page as well as the amount of time it will take for the page transition to 
complete. Currently, they are only supported in Internet Explorer but that's 
okay because IE is the world's most used browser. There are many, many effects 
to choose from. 

 

http://www.vodahost.com/
http://www.vodahost.com/vodatalk/adding-elements-your-website/9307-setting-up-your-page-properties.html


16. 
 

The BlueVoda website builder is brought to you by: VodaHost.com 
Get a Free Domain Name, Unlimited Disk Space, Unlimited Bandwidth and Much, Much More ... 

You Will Love It! 

TUTORIAL: 
Importing an existing HTML page into BlueVoda 
CLICK HERE for Video Tutorial 
 
This tutorial will show you how to import an existing HTML page into BlueVoda. 
 
From the Menubar, select File > New Page > From Existing HTML Page to open the Import HTML Page 
dialog. 
 
Decide if you wish to import the page from your local computer or remotely from an online location. 
 
If you’re importing from your local computer, click “Browse for a file” to browse for the page. You can 
also conveniently locate the page by clicking “Select link from Internet Explorer Favorites” and selecting 
a link in your Internet Explorer bookmarks. 
 
To import a page from an online site, select the “Remote (on the Internet)” option. Then enter the URL 
of the page you wish to import in the “URL:” field. Click the [ OK ] button when you are done. 
 
This will return you to the work-space and you will see that the page you selected has been imported 
onto your work-space. 
 
Note that since you are not importing any CSS file, you will have to reformat the text after importing the 
page. 
 
Repeat the steps above to import an existing HTML page into BlueVoda. 
 
 

TUTORIAL: 
Previewing and Printing your Website 
CLICK HERE for Video Tutorial 
 
This tutorial will show you how to preview and 
print your site in BlueVoda. 
 
To preview your site, click the Preview button 
in the toolbar. This will launch your default 
browser to preview your web page. 
 
To preview your site in a web browser other 
than your default browser, select: Preview in 
Browser... and then select your browser. 
 
To print the current page, simply click the Print icon in the toolbar to open the Print dialogue box. 
 

http://www.vodahost.com/
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You can also access the Print Preview via the main menu bar by selecting: File > Print Preview – Once 
previewed, you can simply click to print. 
 
 

TUTORIAL: 
Publishing Your Site in BlueVoda 
CLICK HERE for Video Tutorial 
 
Here, we'll show you how to publish your site in BlueVoda. - You can publish via the main menu bar: File 
> Publish... will open the Publish Web Page dialog. 
 
You can also publish via the Publish icon in the toolbar. 
 
Important: You should take note that you must publish each page individually. 
 
Once you have the Publish Web Page window open, select the IP where your account resides. You will 
see the IP as well as your login details in your Welcome Email. 
 
Your root directory is public_html. Unless you need to publish to a specific sub-folder, leave this setting 
as is. 
 
If you like, you can “remember” your user-name and password for future log-ins. 
 
Click the [ Publish ] button to publish your web-page to the Internet. 
 
Trouble Publishing? - Below are the possible reasons why... 
 

1. You don't have a VodaHost web hosting account. You need a VodaHost web hosting account and 
a domain name in order to publish your website on the internet. Click Here to create your 
VodaHost Account. 
 

2. If you do have a VodaHost account and you are having problems publishing this could only mean 
that your firewall is blocking and preventing BlueVoda from doing its job. Please momentarily 
disable any firewalls that you have on your computer or add BlueVoda to your safe programs 
list. 
 

3. Also please make sure that you are selecting the correct IP address from the drop down menu. If 
you do not see your IP address in the drop down menu, please upgrade to the latest version of 
BlueVoda. 
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TUTORIAL: 
How to create printer friendly Web Pages 
 
Before we begin, I need you to understand that a web page by its very nature is not really meant to be 
printed. 
 
A web page is specifically designed to be viewed on the internet via a computer screen; if you want it to 
print nicely you must make it printer friendly from the very beginning... 
 
For example, if you where to print out this page it would come out distorted and use up several pieces 
of paper. 
 
Have you ever visited a website that had a button that said... 
 
... "Click here for a printer friendly version" ... ? 
 
Tips for creating a printer friendly page... 
 

1. White background. 
 

2. Text Aligned left. 
 

3. No more than 150 characters of text per line 
 

4. Little or no graphics. 
 

5. Etc.... 
 
After you have created your printer friendly web page, print it out a few times to test how it looks and 
tweak your design accordingly. 
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BlueVoda's Edit menu 
 
BlueVoda's Edit menu allows you to control the position and relative 
positioning, giving you complete control over the design and layout of 
your website. 
 
Undo (Alt + Backspace) Undo a change that you have made to 

the active page. 
 
Redo  Redo a change that you have undone 

on the active page 
 
Cut (Ctrl + X)  Copy an element of your active web 

page to the clipboard. When the 
element is pasted into the new 
location, the original will be deleted. 
Use Copy if you are unsure. 

 
Copy (Ctrl + Insert)  Copy an element of your active web 

page to the clipboard. It can be pasted 
using the Paste command. 

 
Paste (Ctrl + T)  Paste an element from the clipboard into your active web page. The 

element being pasted could have been copied from within your active 
page, from another open web page in BlueVoda or from another 
program (e.g. Notepad) 

 
Paste in Place  Pastes the copied element in the same position that the element was 

copied from (i.e. retains position information) 
 
Delete (Delete)    Delete an element from your web page. 
 
Select All (Ctrl + A)   Select all the elements within the active web page. 
 
Lock  Locks a selected website element (eg. image, text box etc.) in place so 

that it cannot be moved or resized. 
 
Unlock  Unlocks a selected website element so that it can once again be moved 

and / or resized freely 
 
Lock All  Locks all your website elements in place so that none of them can be 

moved or resized. 
 
Unlock All  Unlocks all the elements that have been added to your web page. All 

your website elements can now be dragged and dropped to a new 
location within your website and/or resized. 
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Don't Publish Assets   Allows you to exclude an object's assets from being published. 
 
Restore Original Size  Restores the original size of any website element that you have added 

to your active web page and subsequently resized. 
 
Properties... (Ctrl + T)  Shows the properties of any of the website elements that you have 

added to your active web page. 
 
HTML... (Ctrl + H)  Shows the HTML code that builds up your website that has been 

generated by BlueVoda has generated. 
 
 

TUTORIAL: 
Locking and Unlocking Objects in BlueVoda 
CLICK HERE for Video Tutorial 
 
Normally, you can drag any element you have added to your website page to anywhere on the page. 
 
However, you have the option to lock the element into place so that you do not accidentally move it out 
of position. 
 
To lock an element in place on your website page, simply right-click on the element that you wish to lock 
and select: Lock. Anytime you now try to move the image, you will see that it is locked in place. 
 
It's just as easy to unlock it; simply right-click on the element that you wish to lock and select “Unlock” - 
Anytime you try to move the image, it will once again move freely. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.vodahost.com/
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BlueVoda's View menu 
 
The View menu in BlueVoda controls how BlueVoda's menus and tools are 
presented to you on the BlueVoda workspace. Both are fully customizable 
for a website building experience that is fully tailored to the user. 
 
Menubar Select whether to show or hide the 

BlueVoda main Menubar 

 
Toolbars 
 

Advanced Tools Select whether to show or hide the 
Advanced Tools toolbar 

 
Align Tools Select whether to show or hide the Align 

Tools toolbar 
 

Extra Select whether to show or hide the Extra 
toolbar 

 
Format   Select whether to show or hide the Format toolbar 

 
Form   Select whether to show or hide the Form toolbar 

 
HTML   Select whether to show or hide the HTML Tools toolbar 

 
Image Tools  Select whether to show or hide the Image Tools toolbar 

 
Login Tools  Select whether to show or hide the Login Tools toolbar 

 
PayPal Tools  Select whether to show or hide the PayPal Tools toolbar 

 
Standard Tools  Select whether to show or hide the Standard Tools toolbar 

 
Table Tools  Select whether to show or hide the Table Tools toolbar 

 
Status Bar   Select whether to show or hide the BlueVoda status bar 
 
Layer Manager Open the layer manager, providing you an overview of each layer of 

your active web page from background to objects in the direct 
foreground. 

 
Refresh (F6)   Reloads your active web page within the BlueVoda website builder. 
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Grid Select whether to show or hide the workspace grid, to help you align 

objects within your active web page. 
 
Snap to Grid Select whether to make the workspace grid magnetic, to help you align 

objects within your active web page. 
 
Rulers    Select whether to show or hide the workspace rulers. 
 
Ruler Guides   Select whether to show or hide the ruler guides. 
 
Customize... Fully customize all the Toolbars and Menus of the BlueVoda website 

builder. 
 
Object Outlines Select whether to show or hide a border around each element that you 

add to your workspace. 
 
Page Properties...   Edit all the properties of the active web page that you are editing. 
 
Page HTML...   Edit the HTML source code of the active web page that you are editing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.vodahost.com/


23. 
 

The BlueVoda website builder is brought to you by: VodaHost.com 
Get a Free Domain Name, Unlimited Disk Space, Unlimited Bandwidth and Much, Much More ... 

You Will Love It! 

BlueVoda's Insert menu 
 
This is where the magic happens; the BlueVoda Insert menu allows you to 
add all the elements that you will need to build your website to the 
BlueVoda work-space. You can customize the position, size and shape of 
each element that you add to the BlueVoda work-space and double-
clicking on each element allows you to fully customize that element. 
 
Select  Choose the Object Selection tool. You can now 

select and resize workspace objects 
 
Horizontal Line  Insert a Horizontal Line to your workspace 
 
Text    Insert text into your active web page 
 
Image    Insert an image into your active web page 
 
Marquee   Insert a marquee into your active web page 
 
Bulleted List  Insert a Bulleted (Un-Ordered) List into your active 

web page 
 
ClipArt   Insert a ClipArt into your active web page 
 
Shape    Insert a Shape into your active web page 
 
TextArt   Insert a TextArt into your active web page 
 
Link... (Ctrl + K)  Insert a link into your active web page where you have selected text as anchor 

text or another object 
 
Bookmark  Insert a Bookmark into your active web page 
 
Form 
 

Form Area  Add a form to your active web page and define the area your form will 
take up on the page. 

 
Advanced Button  Add an Advanced button to your form. Double click to edit the 

properties of the button 
 

Captcha   Add a captcha to your form. 
 

Checkbox   Add a checkbox to your form 
 

Combobox   Add a combobox to your form 

http://www.vodahost.com/


24. 
 

The BlueVoda website builder is brought to you by: VodaHost.com 
Get a Free Domain Name, Unlimited Disk Space, Unlimited Bandwidth and Much, Much More ... 

You Will Love It! 

 
Editbox   Add an editbox to your form 

 
File Upload   Add the opportunity for a user to upload a file using your form. 

 
Image Button   Add an image to your form to be used as a button. 

 
Push Button   Add a button to your form. 

 
Radio Button   Add a radio button to your form. 

 
reCaptcha   Adds Google’s reCaptcha tool to the form you are creating  

 
Text Area   Add a text area to your form. 

 
Form Wizard  Starts BlueVoda’s form wizard and allows you to build to create a full 

form quickly from scratch 
 
jQuery UI  
 

jQuery Accordian Add accordion-style menu functionality to your active web page using 
the jQuery JavaScript Library. 

 
jQuery AutoComplete Add a field with auto-complete functionality to your active web page 

using the jQuery JavaScript Library. 
 
jQuery Button Add a jQuery button to your active web page using the jQuery 

JavaScript Library. 
 
jQuery Date Picker Add a field with calendar/ date-picker functionality to your active web 

page using the jQuery JavaScript Library. 
 
jQuery Dialogue Add dialog functionality to your active web page using the jQuery 

JavaScript Library. 
 
jQuery Progress Bar Add progress bar functionality to your active web page using the jQuery 

JavaScript Library. 
 
jQuery Slider Add slider functionality to your active web page using the jQuery 

JavaScript Library. 
 
jQuery Tabs Add tabbed browsing functionality to your active web page using the 

jQuery JavaScript Library. 
 

Login 
 

Admin    Add a change password form to your active web page 
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Change Password  Add a change password form to your active web page 

 
Login    Add a login form object to your active web page 
 
Login Name  Adds an object to your active web page to display the name of the 

logged in user 
 
Logout    Adds a logout object to your active web page 
 
Password Recovery  Adds a password recovery object to your active web page 

 
Protect Page    Adds a protect page object to your active web page 
 
Sign-Up    Adds a “Sign-Up” object to your active web page 
 
User redirect    Adds a user redirect object to your active web page 
 
Single Page Protect   Adds a Single Page Protect object to your active web page 
 

Advanced 
 

Inline Frame   Add an inline frame (iFrame) to your active web page 
 

HTML    Add custom HTML code to your active web page 
 

Layer    Add a layer to your active web page 
 

Script    Add a programming script to your active web page. 
ActiveX   Insert ActiveX to your website 

 
Embedded OLE object   Insert an embedded OLE object into your active web page 

 
File Publisher  This component automatically uploads the files you specify to your 

website once you publish the page. This is helpful if you want to include 
extra files which are part of the page (could be scripts or multimedia 
files). 

 
Flash     Add a flash element to your active web page 
 
Java     Add Java to your active web page 

 
Plug-In     Add a plug-in to your active web page 

 
QuickTime    Add a QuickTime element to your web page 

 
Real Media    Add a Real Media element to your active web page 
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Windows Media Player  Add a Windows Media Player element to your active web page 

 
YouTube    Adds a YouTube video element to your active web page 
 

 
Extra 
 

Ad Banner Rotator   Add an Ad Banner Rotator to your active web page 
 

Banner     Add a banner to your active web page 
 

Conveyor Belt    Add a conveyor belt of images to your active web page 
 
 

ImageMap   Add an ImageMap to your active web page 
 

Glass Button   Add a Glass Button to your active web page 
 

Guest Book   Add a Guest Book to your active web page 
 

Lightbox   Add an image Lightbox to your active web page 
 

Logo    Create and Add a logo to your active website 
 

Photo Gallery   Add a photo gallery to your active web page 
 

Rollover Image  Add a rollover image to your active web page 
 

Rollover Text  Displays a text banner over image on mouse over. Includes cool slide 
and fade effects. 

 
RSS Feed   Add a link to your RSS Feed on your active web page 

 
RSS Viewer Display RSS feeds (local or from another website), Twitter messages, 

Flickr images, Myspace blogs or other news sources on your website 
(with various display types: static, scroller, slideshow, paginate). 

 
Navigation 
 

Go Menu    Adds a Go Menu to your active web page 
 

Menu bar    Adds a menu bar to your active web page 
 

Navigation Bar    Adds a navigation bar to your active web page 
 

Slide Menu    Adds a slide menu to your active web page 
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Tab Menu    Adds a tab menu to your active web page 

 
Text Menu    Adds a text menu to your active web page 

 
PayPal 
 

Buy Now Button   Add a Buy Now PayPal button to your active web page 
 

Add to Cart button   Add an Add to Cart button to your active web page 
 

View Cart Button  Add a view Cart button to your active web page so that your 
visitors can view items they have added to their cart. 

 
Subscription Button  Add a button allowing you to create PayPal subscriptions from 

your web page. 
 

Donation Button   Add a PayPal donation button to your website. 
 
Ready to use Java Scripts... Choose from many Java Scripts to liven up your active web 

page. It is recommended that you only use one Java Script page. 
 
 

TUTORIAL: 
Working With Text in BlueVoda 
CLICK HERE for Video Tutorial 
 
To add text to your website page, click the Text 
Button in the toolbar. A drag-able box will appear 
that you can place anywhere on your website 
page. 
 
To edit the text, double-Click the text box that you 
created and add and/or edit your text. 
 
With the text in the box highlighted, you can specify the font face and size of the text. Similarly, you can 
align any text within the text box (left, right or centered) by using the align buttons in the toolbar. 
 
You can also highlight individual words and set them to Bold, Italic or Underlined, or any combination of 
these. 
 
Text color can also be set by highlighting your text and using the Text Color button and drop-down 
menu. 
 
You can even add a background highlight color to your text by selecting the text and using the 
Background highlight button and drop-down menu. 

http://www.vodahost.com/
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TUTORIAL: 
Working with Images in BlueVoda 
CLICK HERE for Video Tutorial 
 
Working with images in BlueVoda is fun and easy. 
 
To add an image to your page, first click the Image icon in the toolbar 
 
This will open up the Open dialogue, which gives you the opportunity to browse for the image that you 
would like to add to your website page. 
 
Once your image appears on the page, you can now drag it anywhere you would like to on the page. 
 
You can also re-size your image, by dragging any of the handles surrounding the image. 
 
You have access to many more editable image properties once if you double-Click on the image you 
have added. 
 
The Alt-Text can be edited, for example, and it is this that will be displayed in the event the visitor has 
images turned off in their browser, or if they are viewing your website through a text-browser. Alt-Text 
also counts towards the Search Engine Optimization of your website. 
 
You can edit the size of your image and you can also add a border with a color of your choice. 
 
You can also hyperlink the image so that a visitor can click on it and visit another web page. 
 
Right-Clicking on the image at any times gives you the opportunity to lock the image in place, unlock the 
image and even access the Image Properties dialog. 
 
 

TUTORIAL: 
Using the Lightbox Feature in BlueVoda 
CLICK HERE for Video Tutorial 
 
The Lightbox feature allows you to conveniently display a number of images as thumbnails in a 
formatted table. You site users will be able to see the full size of any thumbnail simply by clicking on it. 
 
Click the Lightbox icon in the left menu bar. 
 
You can drag the images to any position on the page. 
 
You can re-size the image area by dragging any of the external handles. 
 
Double-Click anywhere in the image area to open the configuration dialogue window. 
 

http://www.vodahost.com/
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Click Add to add images to the lightbox. - You can add images individually or all at once if they are 
contained within the same folder (holding Shift as you select) 
 
Once you have added your images to the lightbox, you can change their order of presentation by 
selecting an image and using the Move Up or Move Down buttons to the right of the list. 
 
You can also give the thumbnail images a title if you wish using the “Thumbnail Title:” field 
 
Using the Thumbnail Size: drop-down menu, you can select a specific thumbnail size or you can allow 
the images to be re-sized proportional to their original size. Bear in mind that if your images are all the 
same size, you can pick a specific thumbnail size without any issues but if the original images vary in size, 
it is recommended that you select the Variable option, so that the thumbnails are not distorted after 
resizing. 
 
Style Tab: 
 
Check the “Include title in gallery” check-box if you wish to display thumbnail titles. You can then format 
the text to your liking. 
 
You can also assign a border to the images. By default, no border is added. 
 
When you're done, you can click [ OK ] to add the Lightbox to your website page. 
 
You will see that the images have been added to the website page. If you would like to see the results 
right away you can preview the page to see the results. 
 
To do this, click the preview button and you will see that you can click any image thumbnail to see the 
full-size version. 
 
The below is a real live customer's website, who is using the BlueVoda Lightbox, click on any of the 
images... 
 
website link >>>> http://www.thai-land-house.com  
 
 

TUTORIAL: 
PayPal Integration in BlueVoda 
CLICK HERE for Video Tutorial 
 
With a few simple steps you can use PayPal as a payment method for your website. 
 
To add a PayPal “Buy Now” button, just click on the icon on the toolbar at the top. The button will 
appear on your page and you can drag it anywhere you like on the page and you can re-size the button 
area by dragging any of the external handles. 
 
Double-Click the newly added and placed button to open the configuration dialogue window. 

http://www.vodahost.com/
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In “PayPal Account:” Enter the email you use to log-in to PayPal 
 
“Button Image:” lets you select which button style you would like to use. Experiment a little until you 
find the one that you'd like to use on your website. 
 
Details Tab: 
 
Here, you enter the item ID of the item you are selling. Note that Item ID/number is optional. 
 
Add the name of the item or service you are selling, the price and currency and check the “Allow  
Customer to Edit Quantity” box if you would like your customers to be able to purchase multiples of this 
item. 
 
Shipping Tab: 
 
Enter any shipping or handling charges if applicable and you can check the two check boxes on the right 
if you require shipping information, and if you would like to allow the visitors to enter a customer note. 
 
URLs Tab: 
 
Enter full URLs in the “Successful Payment URL:” and “Cancel Payment URL:” fields for your success and 
failure pages. 
 
Click [ OK ] when you are done. 
 
Aside from a Buy Now Button, there are other types of button you can add... 
 
You can add an Add to Cart button (which will allow the visitor to continue adding items to the cart 
before checking out) 
 
You can add a View Cart button allowing a visitor to review what has already been added. 
 
You can add a Subscription button. This is used when you are setting up a customer with recurring 
payments. 
 
You can create a Donation button which will allow your visitors to send you a voluntary donation. 
 
 

TUTORIAL: 
Creating and Configuring Menu-Bars in BlueVoda 
CLICK HERE for Video Tutorial 
 
Click the Navigation button in the left toolbar. 
 
Double-Click the menu bar to view and edit its properties 
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You can now select and edit each menu button individually (click on the button you would like to edit 
and click [Edit...]) 
 
Give the button a name. This is what your visitors will see on the button. 
 
Enter Alternate Text: Alt text is the text that is displayed in the event a visitor has images turned off in 
the browser. Alt text also helps in search engine optimization From the “Link Type:” drop-down, select 
the type of link that you are creating. Usually it will be http: if you are linking to a web page. 
 
In the URL: field, you can now enter the destination field manually, select it from your favorites or 
browse to the file. - You should always enter the entire URL. Note that if you are linking to a page in your 
own site, be sure to refer to it with the .html extension. 
 
Using the Target: drop-down menu, you can specify the target. For instance, if you would like the page 
to load in a new window, select “_blank” 
When done click [ OK ] 
 
Back in the General tab of Navigation Bar Properties; repeat the above process for all the buttons. 
 
You can also rearrange the order by moving any button up or down using the [ Move Up ] and [ Move 
Down ] buttons. 
 
If you like, you can add additional buttons or remove existing ones by using the [ Add... ] and [ Remove ] 
buttons. 
 
Using the “Type:” drop-down menu you can select if you want the menu-bar you are creating to be 
vertical or horizontal. 
 
In the Style tab: 
 
Here you can specify text attributes. For instance you can change the mouse rollover color by activating 
the “Mouse Over Color:” drop-down menu and selecting Red, for instance. 
 
Select from the many menu-bar buttons styles available from the Image section. In the Mouse Over 
Sound Effect section you can browse for a sound effect to use when the mouse moves over a link 
 
With all your Navigation Bar Properties set, when you mouse over the button in the Preview window, 
the text changes to the color you selected above. 
 
When you're happy with the results, click [ OK ] 
 
As when adding any element to the page, you can move the menubar anywhere you like on the page. 
 
As you can see, building a menubar in BlueVoda is as simple as a few mouse clicks. 
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If you want to create navigation bars (menu bars) that will link your pages together, please follow the 
below instructions to the letter. 
 

1. Watch this tutorial video to learning the basics about hyperlinking. 
 

2. Double Click on the menu bars to launch the Navigation Bar Properties editor. 
 

3. Press the Edit button to launch the edit box. 
 

4. Let’s say you created a page called products and you want to link to that page, when you save 
that page you will notice that BlueVoda saves all the pages with a .bvp extension at the end of 
every page name. 
 
In the URL box do not type http://www.example.com/products.bvp (This is WRONG) 
 
Type http://www.example.com/products.html 
 
Replace the .bvp extension with a .html extension 
 
Remember: 
 
a) You must always use the .html extension when typing out a hyperlink 
 
b) You must type the full page URL in the URL field 
 

5. Change the .bvp to .html and use a slash ( / ) to separate your domain name and the page 
name. 
 
Repeat the same process for all the pages you want to hyperlink. 
 

6. After you are finished creating your links, click the "style" tab to add customization and 
functionality to your menu buttons. 
 
In the style section you can: 
 
a) Change the type, size and color of the font in your menu bars. 
 
b) Add a rollover effect to your menu bars. 
 
c) Add a sound effect to your menu bars. 

 
Fast Facts 
 
You cannot test the menu bars unless you have a live active domain name. 
 
 
 

http://www.vodahost.com/
http://www.vodahost.com/vodatalk/hyperlinking-making/9315-linking-creating-hyperlinks-text-images.html
http://www.example.com/products.html


33. 
 

The BlueVoda website builder is brought to you by: VodaHost.com 
Get a Free Domain Name, Unlimited Disk Space, Unlimited Bandwidth and Much, Much More ... 

You Will Love It! 

TUTORIAL: 
Creating Drop-Down Menus in BlueVoda 
CLICK HERE for Video Tutorial 
 
Start by clicking the sliding menu icon in the side toolbar. Double-Click it to open the Menu Bar 
Properties window. 
 
Let's first go ahead and create a couple of top level menu items – Click the [ Add... ] button to do this. - 
Give the new menu item a label (in the “Text:” field). This is what is displayed to your visitors. 
 
From the “Link Type:” drop down menu, select the type of link you wish to create. For a regular web 
page, select http: 
 
Enter the URL of the destination page in the “URL” field. Note that if you are pointing to a page in your 
site, be sure to refer to it with an .html extension. 
 
Using the “Target:” drop-down menu, you can specify if you would like the page to open in a new 
window or in the same window. 
 
When you're done editing the options, click [ OK ]. 
 
Back in the General tab of the Menu Bar Properties, click [ Add... ] to add another menu item. 
 
Again in the Add Menu Item window, fill in the details that you want for your next menu item as you did 
before, and click [ OK ]. 
 
That's two top level menu items created … Now let's create a sub menu item. 
 
Select one of your top level menu items and then click the [ Add... ] button to the right to add a sub 
menu entry under the top level domain that you selected. 
 
Select this sub menu entry and click the [ Edit... ] button to define your selections for this sub menu 
item. 
 
Using the “Layout:” drop down menu, you can specify if the menu should be horizontal or vertical. 
 
Click [ OK ] when you're done specifying your options. 
 
To see the effect of the drop down menu, you can preview the page. 
 
Click the Preview button on the top menu. In the preview screen, mouse over the top menu items to see 
their sub menu items and so on. 
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TUTORIAL: 
Creating Hyperlinks in BlueVoda 
CLICK HERE for Video Tutorial 
 
In BlueVoda you can hyperlink images and text. Let's create a link for an image. Select an image on your 
web page and then click the Hyperlink icon in the toolbar. This will open the “Insert Hyperlink” window. 
 
Here, from the “Link Type:” drop down menu, select the type of hyperlink that you would like to create 
(e.g. http:) 
 
Enter the destination URL in the “URL:” field. Note that if linking to a page in your site, you should make 
sure you refer to the page with an .html extension. 
 
Using the “Target:” drop-down menu, you can decide if the link will display in a new window (by 
selecting “_blank”) or the same one. 
 
Click [ OK ] when you are done setting the options in the “Insert Hyperlink” window. 
 
Now, let's hyperlink some text. Click on the text box containing the text that you would like to hyperlink 
and select the text within the box that you wish to hyperlink. 
 
With the text selected, again click on the Insert Hyperlink button to open the “Insert Hyperlink” 
window. Once here, set your Link Type and add the URL you are linking to in the “URL:” field. 
 
When you're done setting your options in the “Insert Hyperlink” window, click the [ OK ] button. 
 
Note: You can also create a hyperlink for an image by right clicking it and opening the Image 
 
Properties dialogue window (Right-click, select image properties and then visit the Link tab within Image 
properties) 
 
 

TUTORIAL: 
Creating a Go Menu in BlueVoda 
CLICK HERE for Video Tutorial 
 
A Go menu is a hyperlinked menu in a drop down menu. Start by clicking the Go menu icon in the side 
toolbar. 
 
As with any other element you add to a page, you can drag and drop it anywhere you like. 
 
Double click to open the “Go Menu Properties” window. 
 
Click [ Add... ] to add a menu items. 
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Within the “Add Go Menu Items”, in the “Text:” field, create a text label. This is what will appear in the 
drop down menu. 
 
In the “URL:” field, enter the full URL of the destination page. 
 
Using the “Target:” drop-down menu, you can specify if you would like the destination page to display 
in a new window or in the same window. Typically, if it is a page outside of your site, it is recommended 
that you open it in a new window so that the visitor still has your site open in the original window. 
 
When you're done specifying your Add Go Menu Items options, click the [ OK ] button to return to the 
“Go Menu Properties” window. 
 
To add another menu item, click the [ Add... ] button to enter the Add Go Menu Item dialogue. 
 
Add the relevant details here, noting that when linking to one of your site pages, be sure to refer to it 
with an .html extension. 
 
When you're done specifying your Add Go Menu Items options, click the [ OK ] button to return “Go 
Menu Properties” window. 
 
Here you can organize the order of the menu items by moving them up or down using the [ Move Up ] 
or [ Move Down ] buttons. 
 
The “Initial Text:” field: The initial text is what appears as the default text in the drop down menu. 
 
You can edit the text that displays in the button by editing the value in the “Button Text:” field. 
 
Optionally, you can choose not to use a Go button at all, by checking the “Do not use button (dropdown 
menu selection will trigger the link)” check-box. When a visitor selects a menu item, the destination 
page will automatically be displayed. This is more commonly referred to as a jump menu. 
 
When you're done making all your selections, click the [ OK ] button to return to the work-space. 
 
To see what your Go Menu will look like, click the Page Preview button. 
 
 

TUTORIALS: 
Creating a Text Menu in BlueVoda 
CLICK HERE for Video Tutorial 
 
Click the Text Menu icon in the left Toolbar. 
 
You can drag the text-menu anywhere on the page and you can resize the menu by dragging any of the 
external handles. 
 
Double-click the menu to open the configuration dialogue window 
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Double-Click any item to configure or edit its parameters. 
 
You can also click to add a new link to the menu. 
 
Enter the name for the link – This is the name that will be displayed on your page. - You can enter 
Alternate Text, which is what will be displayed when your visitor mouse over the link. 
 
Select the type of link you wish to create, enter the destination URL for the link. Alternatively, you can 
specify the URL by selecting from your IE favorites, or by browsing for a page in your own site. 
 
Using the “Target:” drop-down, you can launch the destination URL in a new browser window. Leave it 
blank if you would like it to display in the same window. 
 
You can display the menu either vertically or horizontally using the “Type:” drop down menu. 
 
You can rearrange the order of links by moving them up or down in the list (using the [ Move Up ] and [ 
Move Down ] buttons) – in addition you can Add new links or remove exiting ones using the [ Add... ] 
and [ Edit... ] buttons. 
 
In the “Style” tab: 
 
You can configure the appearance and format of the text links. 
 
You will notice that the text menu is able to optionally display delimiters around each link. A delimiter is 
a sequence of one or more characters used to specify the boundary between separate, independent 
regions in plain text or other data streams. In the Delimiters section, you can enter any type of delimiter 
here. To enable the delimiter feature, you will have to check the “Include delimiters in link” check-box 
to enable this feature if you wish to show delimiters in the menu. 
 
When you're done configuring the options here, click [ OK ] to return to the main menu. 
 
You may need to re-size your text menu in order to accommodate any new links that may have just been 
created. 
 
 

TUTORIAL: 
Adding HTML in BlueVoda 
CLICK HERE for Video Tutorial 
 
Note: BlueVoda is an HTML generator not an HTML creator or editor. If you wish to edit the HTML code, 
you must generate it externally and then add it to BlueVoda. 
 
Click the HTML icon in the left menu to add HTML to the page. 
 
Double-Click the HTML element to open the “HTML Properties” window. 

http://www.vodahost.com/
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You can go ahead and add your HTML code here or alternatively, you can import code by importing an 
entire file. 
 
As with any other element, you can drag and drop the code anywhere on the page. 
 
You should note that you will only be able to see what it actually looks like either in preview mode or by 
publishing to the site and viewing the site online in your browser. 
 
 

TUTORIAL: 
Working with shapes in BlueVoda 
CLICK HERE for Video Tutorial 
 
To get started working with shapes, click the Shape icon in the toolbar. 
 
Double-Click the shape that appears in your work-space to open the “Shape Properties” dialogue box. 
 
Decide which shape you would like to create, using the “Type:” drop-down menu in the Shape section of 
the “General” tab. 
 
You have controls to manipulate the shape as you work, for example, if you choose the Round 
rectangular type of shape, you can specify “roundness” factor of the corners. 
 
You should also enter some Alternate Text for the shape that you have created. Alt. text will display in 
the event that a visitor has images turned off or is viewing 
 
Select a fill effect and select a fill color from the Fill Effects section 
 
If you would like the shape you have created to have a border, check the “Enable Border” check-box in 
the Border section and then define the attributes for the shape's border. 
 
When you are done creating your shape, click the [ OK ] button to apply the changes you have made and 
to return to the work-space. 
 
With your shape created, you can drag it to any position on the page and you can also resize the shape 
by dragging any of the handles. 
 
You can now add more shapes to your web-page. 
 
Again, click the Shapes button on the toolbar and double-click the shape to open the Shape Properties 
window. 
 
If you wish, you can also hyperlink the shape and, after clicking the [ OK ] button, you can move your 
newly created shape anywhere you wish on your web-page. 
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TUTORIAL: 
Creating a template using a BlueVoda template background 
CLICK HERE for Video Tutorial 
 
You can go directly to our Image Gallery and download some templates by clicking the icon in the 
bottom navigation bar. 
 
For example, select Set #3 for download – and save it to your Disk. 
 
Best practice suggests that you create a folder to save all your templates to. 
 
At this point, use your favorite zip utility program (eg. WinZip) to decompress the files in the zip you 
downloaded. 
 
To add one of the template backgrounds to the page, click the Image icon from the toolbar and browse 
for the file. 
 
Drag and drop the design to wherever on the page you want on the page. 
 
You can now start to add additional page content on top of this background design. Don't forget to save 
the page as a template. 
 
That's it – you have now created a BlueVoda template using a BlueVoda template background. 
 
 

TUTORIAL: 
Creating a new form based on a template in Form Wizard 
CLICK HERE for Video Tutorial 
 
To get started, click on the Form Wizard icon in your BlueVoda toolbar. In this example, we'll create a 
new form based on a template. With the “BlueVoda Form Wizard” open, make that selection: “Create a 
new Form based on a template.” Click [ Next > ] to move on to the next step of the form wizard. 
 
There a great many preconfigured forms depending on your requirements – You can preview them by 
clicking on each and then looking to the display on the right. When you have selected the form that you 
would like to use, click [ Next > ] to move on to step 3 of the form wizard. 
 
When Step 3 of 4 opens, at this point, you can highlight any form elements and click [ Edit... ] to edit its 
attributes. In addition, using the [ Remove ], [ Move Up ] and [ Move Down ] buttons, you can remove a 
form element all together or move it up or down. You should note that you can perform any of these 
tasks after the form has been created. 
 
Press [ Next > ] to move on to step 4. 
 
In the final step in the Form Wizard, step 4, you must give the form a name in the “Form name” field. 
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This name is not case sensitive but you must ensure that you do not add any spaces in the name. 
 
Using the Form action: drop-down menu, the default setting will typically be the one you wish to use 
unless you have other specific requirements. 
 
In the “Email address:” field, enter the email address where you wish to receive form submissions. 
 
In the “Subject:” field, enter the text you wish displayed in the Subject line of the email notification. 
 
Next, move on to the “Encoding type:” field – In most cases you will not need to use this attribute at all. 
The default value (i.e. if you do not use this attribute at all) is “application/x-www-formurlencoded”, 
which is sufficient for almost any kind of form data. The one exception is if you want to do file uploads. 
In that case you should use “multipart/form-data”. 
 
Using the “Success URL:” and the “Error URL:” fields you can specify the success and failure pages where 
the visitor will be sent after completing the form. Note that these pages are not automatically created – 
you will have to create them yourself with BlueVoda. 
 
When you're done with step 4 of 4, you should click the [ Next > ] button. 
 
You have successfully entered all of the information required to setup a new form. You should now click 
the [ Finish ] button to insert the form to your web page. 
 
You will arrive at your work-space and will see your newly created form waiting for you. - You can drag 
and drop the form to where you want it on your web-page. 
 
Remember to save your web-page containing your form when you are done building it or if you are done 
making changes to it for the time being. It will be saved as a .bvp file. However, unlike other regular site 
pages that are published as .html, any page containing a form will be published as .php You have now 
only to publish the page to set it live on your site. - You do this by clicking the publishing button and 
entering the relevant details and clicking on [ Publish ]. The Successfully published window let's you 
know when this has been done. 
 
The major enhancement in the new Form wizard, which also applies to all BlueVoda forms 
independently from the way they have been built, is the Built In Form Processor. This form processor 
eliminates the need to copy / paste php code and manually create a processing page. The processing 
script is automatically embedded in your own form page, and it will process your form info correctly. It 
takes down to practically zero copy / paste mistakes that have caused lots of frustration to many users. 
This script has been created with the contribution of DBTechnosystems and has the following 
enhancements, in comparison to the one used in the BV forms up to this moment: 
 

1. It will automatically take care of file uploads 
 

2. It will take care of Multiple choice Listboxes / Comboboxes 
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3. It will detect injection attempts and deny processing 
 

4. It will report these errors if found 
 

5. It allows you to specify the Upload folder and the max filesize 
 

6. It will add a random prefix to the file uploaded, to avoid hackers uploading and running 
malicious files 

 
Please note that these are essential features, for a more complete script that will provide much more 
both in terms of security and in terms of features, please visit the Advanced BlueVoda Form Processor 
thread. 
 
Creating an Error page 
 
The built in form processor was developed by DB Technosystems.com. We have now embedded a 
simple error reporting system. To be able to report the errors, you need to correctly build an error page. 
 
As we have designed the script, this is an extremely easy task: Create a page as you normally would. 
 
Leave some free space for the text of the error message. Then, place in your page the following simple 
text: ##error## 
 
As you see it in the following example: 
 
If an error is found in your form, the error page will show up. The text ##error## will be replaced by the 
actual error message. You can format the text as you like (Font type, size, color and position, alignment 
etc). Make sure to make it LARGE enough so that there is enough space for it. 
 
Now, insert an ADVANCED button in your page. Double click it, Make it OnClick, and select onClick 
action: Go to the Previous Page. This button will enable your visitor to go back in your form and edit his 
input before submitting again. 
 
Multiple Choice Listboxes / Comboboxes 
 
Sometimes you need such fields. In Addition, there are some tomes that even checkboxes for the SAME 
choice, need to have multiple answers (values). 
 
In order for the built in processor to correctly process these fields, there is only one requirement: the 
file names of these multiple choice fields MUST have at the end, [] (square brackets). In example, a field 
"How did you find us" should be "How did you find us[]" in order for the processor to be able to 
correctly process it. Of course, you also need to check the "Allow Multiple Selections" checkbox in the 
field Properties dialog box. 
 
Uploading Files 
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The new processor allows you to upload files. Normally, the default settings allow a maximum filesize of 
1 Mb and the files will be uploaded in a subfolder that is AUTOMATICALLY created, which is named 
"uploads". 
 
However, it is possible to change the folder name as described in the following steps. 
 
You may also want to change the default maximum filesize, from 1 Mb (1024 Kb) to a lower or higher 
number. 
 
BOTH these tasks are achieved through HIDDEN FIELDS. 
 
Double click your form, and in the lower part, in the Hidden Fields section, add these two fields: filesize 
(all lowercase) and upload_folder (all lowercase). 
 
The filesize MUST be typed in Kilobytes. 
 
Important Notes! 
 

1. There are some limitations to the field naming: the visitor's email address field, MUST be named 
"email", all lowercase, exactly as you see it, so that the script will correctly recognize it. 
Otherwise, the sender's email address will default to your own email address. This is done 
because many ISPs will block emails if no sender email address is included in the mail. 
 

2. Your Submit button name MUST be "submit", and your "reset" button MUST be named "reset". 
If you name them anything else, you will receive those values in the mail along with the others. 
 

3. Please note that when you use the built in form processor, the page NEEDS to be published as 
.php instead of .html. If you have created the form from scratch with the wizard, this is done 
automatically. 

 
So, if your page is named "contact", it will be published as "contact.php". So this is what you should 
include in your menu bars as link to the contact page. 
 
Troubleshooting: If after publishing your form page, you see lots of code on top of the page, don't 

worry, it is simple: you have published your page as html instead of php. 
 
Have fun! 
 
 

TUTORIAL: 
Creating a new form from scratch in Form Wizard 
CLICK HERE for Video Tutorial 
 
This section of the manual will show you how to create a new form from Scratch in Form Wizard. 
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Click the Form Wizard icon in your BlueVoda toolbar and when the BlueVoda Form Wizard – Step 1 of 4 
pops up, click “Create a new Form from scratch using the wizard”. - Click [ Next > ] to proceed. 
 
This will move you straight to Step 3 of 4 in the Form wizard. This is not an error, but it lets you 
customize all the elements in your form, right from scratch ... At this point, go ahead and add whatever 
form elements you wish to display in the form. Let's take a look at form elements. 
 
You can see a list of all the Form elements that you can add to the “Add controls to the form:” by 
clicking the [ Add... ] button. 
 
An Editbox (or Textbox) provides a single line text field. 
 
The Label is what will be displayed next to the element in the form... e.g. “Name” 
 
A Checkbox allows you to let the visitor check off the selection if they wish... e.g. “I am an existing 
customer” 
 
A Combobox will display a drop-down menu allowing the visitor to make a selection... e.g. “Age”. You 
should note that we will further configure this element once the form has been created. 
 
You can add a File Upload utility allowing visitors to upload files to your site... e.g. Upload file. 
 
Hidden Fields are used to perform tasks behind the scenes (not visible to visitors). Use this only if you 
have advanced knowledge of HTML and form creation. 
 
A Radio button allows the visitor to make one selection from a list of options eg... “Add me to mailing 
list.“ 
 
A Text Area is similar to Editbox but allows for multiple lines which allows for more text entry, e.g. 
Comments 
 
IMPORTANT: When you are creating a form manually, do not forget to add a Submit button. If you do 
not add a Submit button, the visitor will have no way to Submit the information that they have entered. 
 
Finally, therefore, you should click on the [ Add... ] button and add the Submit Button. 
 
You also have the option of adding a Reset button which will allow visitors to clear any data they have 
added to the form and start over. 
 
You can highlight any element and move it up or down in the form, or remove it all-together using the [ 
Remove ] [ Move Up ] [ Move Down ] buttons. 
 
You can also edit the label for any element. 
 
Click [ Next > ] to move on from Step 3 of 4 to Step 4 of 4. 
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Give the new form a name in the Form name: field. The name is not case sensitive but you must ensure 
that you do not add any spaces in the name. 
 
Regarding the Form action: drop-down menu, the default setting will typically be the one you wish to 
use unless you have other specific requirements. 
 
In the “Email address:” field, enter the email address where you would like to receive form submissions. 
 
In the “Subject:” field, enter the text you wish displayed in the Subject line of the email notification. 
 
Regarding the “Encoding type:” drop-down menu, in most cases you will be able to use 
“application/xwww-form-urlencoded”, which is sufficient for almost any kind of form data. The one 
exception is if you want to do file uploads. In this case you should use “multipart/form-data”. If you 
have a file upload element in your form, you should select this option. 
 
Using the “Success URL:” and “Error URL:” fields, you should specify a success and failure page where 
the visitor will be sent after completing the form. Note that these pages are not automatically created – 
you will have to create them yourself. 
 
Click the [ Next > ] button to move on to the final page of the BlueVoda Form Wizard. Here, click [ Finish 
] to insert the form to your web page. 
 
The Wizard will close and you will see your newly created form waiting for you in the BlueVoda 
workspace. 
 
You can drag and drop the form to where you want it on your page. 
 
Once you are happy with the placement of the form within your website, you will now need to double-
click certain elements to further configure them ( e.g., a Combobox). 
 
Once you have double-clicked on the Combobox, the Combobox Properties window opens up. 
 
You should give the element a name in the “Name:” field (or you can leave the default name as it is if 
you like) 
 
Once this has been done, you can now add selectable options to the drop-down combobox. Click the [ 
Add... ] button to add elements. When you click the Add... button the Add Item window opens up 
allowing you to add “Item text:” and a corresponding “Value:” . You can also make this one “Selected” 
so that it is selected by default in the form. 
 
When you are done configuring your Add Item options, hit the [ OK ] button – this will return you to the 
Combobox Properties window. To add another option to your Combobox form element, just click the [ 
Add... ] button again. 
 
Keep adding Combobox elements until you are happy with the form element options that you are giving 
your visitors. Click [ OK ] to leave the Combobox Properties window. 
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Remember to save the page when you are done editing your form. It will be saved as a .bvp file. 
 
However, unlike other regular site pages that are published as .html, any page containing a form will be 
published as .php. 
 
Publish the page to set it live on your website. - You should now test it in a web browser. Hopefully the 
form will be submitted and the visitor will be successfully redirected to the success page. 
 
Your form page MUST be published as PHP. This is done through View > Page Properties > File 
Extension (when published). 
 
Many people use the TAB button to move from field to field. As you add more and more fields in your 
form, you might need to set the order in which the TAB button will move the cursor from field to field. 
 
Here is the “official way” to change the TAB order of the elements on an existing form: 
 
Right click the first element of the form and select 'Move to front'. Do this for all your form elements in 
the order you want the tab to go. 
 
 

TUTORIAL: 
Editing a Form 
CLICK HERE for Video Tutorial 
 
You can double-Click the form itself to edit Form attributes. Doing so will open the Form Properties 
dialog window. Here you can edit the man attributes of the form. 
 
You can also edit the general layout for the form using the Layout tab. 
 
You can also edit any individual part of the form. For instance, double-click the text to edit the Label for 
any form element. 
 
You can also double-click a form element to edit its properties. 
 
For instance, you can edit the style properties of the individual element, using its Style tab. 
 
You can also specify if the element is one that is required to be filled out in order to submit the form. 
 
Click [ OK ] when you're done making changes. 
 
You can also further configure buttons, like the radio button for example. - Double-click on it to open 
the Radiobutton Properties window. You can make this option pre-selected. 
 
Similarly, you can edit the properties of a Text area by double-clicking on it. For example, you can display 
some text in the text area... “Enter comments here” for example. 
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Click [ OK ] when you're done. 
 
Finally, you can also add a new element to the form. Let's start by making room for the new element. 
 
To make room for the new element, just use the mouse to grab whatever elements are in the way and 
drag them to their new location. 
 
Then add a new element; in this example, we can add an Editbox so that the visitor can enter an email 
address. – Click the Editbox button. This will add an additional field to your form. You can drag this field 
into any location that you like within the form. To edit its properties, you should double-click on the 
newly added editbox. 
 
In the Editbox Properties window, visit the Validate tab and add data required – make any other changes 
you need to. Make a text box and put it relative to the new field as a label for the field. 
 
That's it! You are now able to edit a form. Don't forget to save and publish the page when you are done. 
 
 

TUTORIALS: 
Creating a Guestbook in BlueVoda 
CLICK HERE for Video Tutorial 
 
Here, we will show you how to add a guest-book in BlueVoda. To get started, click the guest-book icon 
in the left toolbar. - This will add the guest-book feature to your web-page. 
 
As with all BlueVoda elements, you can drag and drop the guest-book anywhere on the page and you 
can re-size the guest-book by dragging any of the external handles. 
 
Once your guest-book is placed to your requirements, you should double-click the guest-book to open 
the configuration dialogue window. 
 
You can create your own title for your new textbook using the Title: field in the PHP Guest-book 
Properties. You can also rename any of the form element labels. Generally, the default labels are more 
than appropriate. 
 
You can configure the style attributes of the guest-book from the “Style” tab; for instance, you can 
select a background color or image, and decide if you wish to display a frame border. 
 
You can specify your choice of color for the links. You can also configure the font styles for the various 
components of the guest-book... For example, next Font styles, click the [ Title ] button to open the Font 
dialogue box and change the font attributes of the guest-book title. 
 
You can also edit the attributes of the form fields. 
 

http://www.vodahost.com/
http://www.vodahost.com/vodatalk/bluevoda-general-issues/22578-create-guest-book.html


46. 
 

The BlueVoda website builder is brought to you by: VodaHost.com 
Get a Free Domain Name, Unlimited Disk Space, Unlimited Bandwidth and Much, Much More ... 

You Will Love It! 

In the “Advanced” tab, if you wish, you can display an Admin link. This will allow you to login to manage 
the guest-book. You can use the default password or create one of your own. It is recommended that 
you create your own unique alpha-numeric password. 
 
Continue to enter your preferences such as allowing URLs, Bbcode, etc. 
 
Hit the [ OK ] button when you are done editing your preferences to return to the workspace. 
 
That's it; you are now able to add a guest-book in BlueVoda. 
 
Extra instructions: 
 

1. Upload 'guestbookdb.php' on your server using BlueFTP. 
 

2. Change the permissions of 'guestbookdb.php' to 755 otherwise you won't be able to write data. 
You can use the FTP Manager add-on (BlueFTP) to upload and change permissions of the 
'guestbookdb.php' file. 
 
a) Login to the FTP server of your website using the BlueFTP. 
 
b) Browse to the folder where you've published the guestbook. 
 
c) Upload 'guestbookdb.php' 
 
d) Select the file and use Properties to set the permissions to 755. You only have to do this once. 

 
 

TUTORIAL: 
Creating an inline frame in BlueVoda 
CLICK HERE for Video Tutorial 
 
Here we will show you how to create an inline frame in BlueVoda. 
 
An inline frame (iframe) is basically a self contained floating frame that has its own scroll-bar for its own 
content. To get started, click the iframe icon to add an inline frame to the page. 
 
You can re-size the iframe by dragging any of the handles. 
 
Double-Click on the iframe to open the Inline Frame Properties window. 
 
In the “Name:” field, give your iframe a name. This can be anything you like – it is for your reference 
only. 
 
Enter the URL of the destination page in the “URL:” field. 
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Using the “Scrollbars:” drop-down menu, select how/when to display a scroll-bar. In addition, if you 
wish, you can display a border around the iframe to better distinguish it from the rest of the content on 
your web-page. You do this using the “Show border” check-box. 
 
The Alternate text: field allows you to add text which will display in place of the iframe in the event that 
the visitor's browser does not support frames. 
 
Click [ OK ] when you're done configuring the properties for your Inline Frame Properties to return to 
the BlueVoda work-space. 
 
Note that the only way you can see what this will look like on the site is either by previewing it or by 
publishing it and viewing the site online. 
 
It's as simple as that; you are now able to add inline frames in BlueVoda. 
 
To re-cap: 
 

1. Double click on the inline frame to launch the properties editor. 
 

2. Name your inline frame. 
 

3. Select the page that you would like to be framed. 
Note: This must be an actual .html page or a website. If you have data on a word doc or a spread 
sheet, you MUST transfer the data to a .html page. 
 

4. Select if want to have scroll bars. 
 

5. Click "OK" when you are done. 
 
After you finish your frame, you will probably have to go back and tweak it a bit to make sure all the 
data is presented attractively. 
 
 

TUTORIAL: 
Adding external elements in BlueVoda 
CLICK HERE for Video Tutorial 
 
When adding external elements to your web-page using BlueVoda, you can select from various elements 
in the left toolbar. 
 
You may wish to add script to your page for instance. You begin this process by clicking the Script button 
in the left toolbar. This will add the Script box to your web-page. Double-click it to open the Script 
Properties window. 
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At this point, you can enter your VBScript. Alternatively, you can add Javascript. You must indicate which 
you are adding by using the selections at the top of the Script Properties window. Click [ OK ] or cancel 
to return to the BlueVoda work-space. 
 
You can also add ActiveX controls to the page. Click the ActiveX button on the left toolbar to be 
presented with a list of options. 
 
You can add Java (you shouldn't confuse this with Javascript!) to your web-page by clicking the Java 
button in the left toolbar. Again, as will all of the external elements, double-click on their symbol on 
your work-space to open the Properties dialogue window. 
 
Similarly, you can add a Flash element to your page by clicking on the flash icon in the left toolbar. 
 
Double-click the image added to your work-space to open up the Flash Properties dialogue window. 
 
If you wish to add a Windows Media file to your web-page, just click on the Windows Media icon on the 
left toolbar. To add a QuickTime movie file, click on the QuickTime icon in the left toolbar. To add a Real 
Player file, click on the Real Player icon in the left toolbar. 
 
You can add a plug-in to your page in the same fashion, by clicking on the plug-in icon on the left 
toolbar. As before, just double-Click on the plug-in icon that has been added to the work-space to open 
the Plugin Properties dialogue window. 
 
The procedure for adding external elements in BlueVoda is straightforward and consistent and very 
easy. 
 
 

TUTORIAL: 
Using the logo maker in BlueVoda 
CLICK HERE for Video Tutorial 
 
Here we'll discuss using the logomaker in BlueVoda. To get started, click the logomaker icon in the left 
toolbar. You can drag and drop the logo anywhere on the page and you can re-size the logo by dragging 
any of the external handles. When you're happy with the size and placement of the logo, double-click 
the logo to open the configuration dialogue window. 
 
The Logo Properties window opens. Start by entering the text you wish to have displayed in the new 
logo in the “Logo Text:” field. 
 
Note that you can see an instant preview of the logos as you make changes in the Preview section of the 
Logo Properties dialogue window. 
 
Using the “Font Type:” drop-down menu select a font type for your logo and using the “Font Size:” drop-
down select a size for the logo text. 
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Use the check-boxes to the right to add additional font attributes such as bold, italic, underline and 
strike-through. 
 
Using the Align Vertical drop-down, you can specify the alignment of the text in the logo. 
 
Continue configuring the logo with regards to text border and shadow. 
 
In the “Logo” section of the Logo Properties window, using the “Shape:” drop-down menu you can 
select a shape for the logo. Using the Border Size menu you can set the size of the border containing the 
logo. 
 
In the “Fill Effects” section of the window you can configure the fill effects for your logo. Start with the 
background attributes. Continue this process until you achieve the look you are looking for. 
 
“Start Color:” and ”End Color:” will dictate which colors are used in gradient fills. 
 
You can do the same for the logo border, text and text border using the “Border”, “Text” and “Text 
Border” tabs in the Fill Effects section of the Logo Properties window. 
 
When you're done, click [ OK ] to save the changes. That's it; you're now able to use the logomaker in 
BlueVoda. 
 
The BlueVoda Logo Maker is designed to furnish your website with a professional logo quickly and 
easily. Beginning with the basic style of the logo which suits you and your site (you can choose from 
plenty of pre-designed templates) you have the ability to completely customize it. Change the size, 
shape and fill it with colors and gradients. Add text, pick the font you want and align it just as you wish. 
You can add and change the borders of the design, making it stand out and even swivel the entire logo 
about its axes, giving it a cool 3D effect. Your logo will always be striking as drop-shadows ensure that 
the text is always clear ... The options here are truly endless for creating a great logo that your visitors 
will always associate with you. 
 
You see it each and every day: NBC’s peacock, KFC’s colonel, Microsoft’s Windows logo, that Apple with 
the bite missing, those Golden Arches. All simple designs, all unique and most importantly, all 
INSTANTLY recognizable. Oh, they’re also all the logos of massive business enterprises, too. 
 
You’re website must have a logo. There’s no way out of it. It sets the character and tone of your website 
and speaks volumes … possibly more so than the text will. It’ll most likely be the first element that your 
visitor sees and if it’s striking, will stick in your customers mind and keep them coming back for more. 
Remember that your clients know what they want. You have to show it to them. 
 
The BlueVoda website builder has the all the tools you’ll need to get this kind of branding done and 
done well. It’s built in Logo Maker feature (seriously just a click away) gives you the ability to create, 
fashion and edit your website’s logo just as you want. You can play with the fonts, colors sizes and 
shapes, whatever is just right for your website. Make it colorful, make it funky, and make it jump off the 
page but always keep it simple and absolutely keep it unique. Good luck! 
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TUTORIAL: 
How to Add Flash 
CLICK HERE for Video Tutorial 
 
Here, we will show you how to insert flash into your website builder project. As with any task in your 
website builder, you must select the action button first then click on the page and drag the mouse. 
 
Double-click to open the Flash Properties dialog. 
 
Select your movie source using the [ .. ] button, then by browsing for the flash file that you wish to add. 
 
With any flash embedded movie you have the option to raise or lower the quality of the flash element 
to save loading time. You can do this using the “Quality:” drop-down. 
 
You can also select loop if you desire your flash element to repeat itself over and over again. You can do 
this by checking the “Loop” check-box. 
 
Click the [ OK ] button when you're done configuring your Flash Properties for that particular element. 
 
That's all you need to do to add a flash objects within the BlueVoda website builder. 
 
 

TUTORIAL: 
How to Insert Movies 
CLICK HERE for Video Tutorial 
 
This tutorial will show you how to insert a movie using the BlueVoda website builder. 
 
As with any task in your website builder, you must first select the action button and then click on the 
page and drag the mouse. Let's go ahead and click on the movie button. You have a selection between 
Windows Media Player or QuickTime files. 
 
For example, click on the Windows Media button in the left toolbar and then drag a space for it to 
occupy on the work-space. This will add the Windows Media Player image to the work-space in the area 
you have selected. 
 
Double-Click on the new window to open the Windows Media Player Properties dialogue which will 
allow you to pick the source for the movie (using the [ .. ] button, browsing for the file you wish to add 
and then clicking the [ Open ] button). 
 
It's as simple as that; you are now able to add a movie using the BlueVoda website builder. 
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BlueVoda's Format menu 
 
The BlueVoda Format menu lets you control your text and images. You 
can format both of them to your heart’s content, controlling many aspects 
of their display. From the simple edits to image editing the format menu is 
a powerful asset to you as you build your website with BlueVoda. 
 
Font...     Change the font of your selected text 
 
Styles...    Changes the style of your selected text 
 
Bold (Ctrl + B)    Make your selected text bold 
 
Italic (Ctrl + I)    Make your selected text Italic 
 
Underline (Ctrl + U)  Place an underline under your currently 

selected text. 
 
Strikethrough   Place a line through your selected text 
 
Superscript   Make your selected text superscript 
 
Subscript   Make your selected text subscript 
 
Left     Align your currently selected text to the left 
 
Center  Align your currently selected text in the 

center of your web page 
 
Right     Align your currently selected text to the left 
 
Justify     Justify your selected text 
 
Symbol 
 

Bullet   Add a bullet symbol to your website 
 

Copyright  Add a copyright (c) symbol to your website 
 

Euro   Add a Euro currency symbol to your website 
 

Pound   Add a British Pound currency symbol to your website 
 

Registered  Add a “Registered” symbol to your website 
 

Trademark  Add a “Trademark” symbol to your website 

http://www.vodahost.com/


52. 
 

The BlueVoda website builder is brought to you by: VodaHost.com 
Get a Free Domain Name, Unlimited Disk Space, Unlimited Bandwidth and Much, Much More ... 

You Will Love It! 

 
Yen   Add a Yen currency symbol to your website 

 
More Symbols... Pick from more symbols to add to your active web page 

 
Change Case 
 

Sentence Case  Capitalize first sentence letter 
 

lowercase  Make all the selected text lowercase 
 

UPPERCASE  Make all the selected text UPPERCASE 
 

Capitalize Each Word Automatically capitalize the first letter of each word 
 

tOGGLE cASE  Toggles (inverts) the case of your selected text 
 
Text Color...    Allows you to change the color of your selected text 
 
Background Color...   Allows you to change the background color of your selected element 
 
Style 
 

None   Removes all styling from your text 
 

Heading 1 <h1>  Styles your selected text as Heading 1 
 

Heading 2 <h2>  Styles your selected text as Heading 2 
 

Heading 3 <h3>  Styles your selected text as Heading 3 
 

Heading 4 <h4>  Styles your selected text as Heading 4 
 

Heading 5 <h5>  Styles your selected text as Heading 5 
 

Heading 6 <h6>  Styles your selected text as Heading 6 
 

CustomStyle  Allows you to style you text as per your exact requirements. 
 
Remove Formatting Removes all formatting that you have added to text and resets it to 

default values 
 
Remove Link Remove a hyperlink from your selected website text, image or other 

element. 
 
Image Tools 
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Flip Horizontal   Rotates your image through 180 degrees about the y-axis 
 

Flip Vertical   Rotates your image through 180 degrees about the x-axis 
 

More Contrast   Increases the contrast of the selected Image 
 

Less Contrast   Decreases the contrast of the selected Image 
 

More Brightness  Increases the brightness of the selected image 
 

Less Brightness   Decreases the brightness of the selected image 
 

Hue/Saturation...  Change the hue and saturation of your selected image 
 

Crop    Crop your image to your specification. 
 

Resample  Lowers (recommended) or raises (not recommended) the size and 
resolution of your selected image 

 
Add/Replace Stencil... 

 
Image Effects 
 

Colors 
 

Colorize Colorize your image 
 

Negative Invert all the colors of your image and give your image a negative effect 
 

Grayscale Make your image Grayscale 
 

Sepia  Add a Sepia effect to your image 
 

Gold  Add a warm gold effect to your image 
 

Ice  Add a cool ice effect to your image 
 

Metallic Add a silver metallic effect to your image 
 

Convolve 
 

Blur  Blur your image 
 

Sharpen Sharpen the focus of your image 
 

Soften  Soften the focus of your image 
 

http://www.vodahost.com/


54. 
 

The BlueVoda website builder is brought to you by: VodaHost.com 
Get a Free Domain Name, Unlimited Disk Space, Unlimited Bandwidth and Much, Much More ... 

You Will Love It! 

Distort 
 

Cylinder Add a cylinder effect to your selected image 
 

Fish Eye Add a fish-eye lens effect to your image. You will be prompted 
to select the value of the effect 

 
Pinch   Add a pinch effect to your selected image 

 
Punch   Add a punch effect to your selected image 

 
Twirl   Add a twirl effect to your selected image 

 
Edge 

 
Edge Linear  Add a linear edge effect to your selected image 

 
Edge Non Linear Add a non-linear edge effect to your selected image 

 
Erode   Add an erode effect to your image 

 
Noise 

 
Jitter   Add the Jitter effect to your selected image 
 
Median   Add the median effect to your selected image 
 
Noise   Add the Noise effect to your selected image 

 
Splash Add the Splash effect to your selected image. You will be 

prompted to enter a value for the effect and you will be able to 
see a preview of what your image will look like. 

 
Other 

 
Emboss   Add the Emboss effect to your selected image. 

 
Inner Bevel Frame Add the Inner Bevel Frame to your selected image. You will be 

prompted to enter values for the effect and you will see a 
preview of what your image will look like once your image has 
been added to it. 

 
Mosaic Add the Mosaic effect to your selected image. You will be 

prompted to enter values for the effect and you will see a 
preview of what your image will look like once your image has 
been added to it. 
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Soft Edges Add the Soft Edges to your selected image. You will be 
prompted to enter values for the effect and you will see a 
preview of what your image will look like once your image has 
been added to it. 

 
 

TUTORIAL: 
Adding Special Characters and Symbols in BlueVoda 
CLICK HERE for Video Tutorial 
 
You can add special characters and symbols when using BlueVoda. 
 
First add text field and text as previous. Click the text button and hold the left mouse button to drag a 
text field. 
 
Double-Click on the text to enter Edit mode and write some text, to the point where you would like to 
add a Symbol (let’s say, in this case, a “$” sign) 
 
Format > Symbol 
 
Note that this option is only available when you are in text Edit mode. If you are not in text-edit mode, 
then this option will be grayed out. 
 
A panel (Insert Symbol) will open containing many symbols. Select the one you want to use (remember 
in this example we are working with the dollar sign) – You have an option to change the font for the 
symbol that you will add, although this is also doable from the text toolbar. 
 
With the symbol you want selected, just click on Insert and the symbol will be added to your text box. 
 
You can repeat this process for each additional special character or symbol that you want to add. 
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BlueVoda's Table menu 
 
BlueVoda's Table menu lets you add and edit tables to your website, 
which are a great way of presenting information and data to your 
website visitors. 
 
Insert table...    Create a table in the active web page. 
 
Insert Rows or Columns...  Insert new rows or columns to the 

selected table in the active web 
page you are working on. 

 
Merge Cells  Combine cells in your table (2 or more) 

into one new cell. 
 
Split Cells    Split a cell in your table to create two (or more) new cells. 
 
Delete Column    Delete a whole column from the selected table in your active web page. 
 
Delete Row    Delete an entire Row from the selected table in your active web page. 
 
Table Column Width... Define a precise width (in pixels) for a column in the selected table in 

your active website. 
 
Table Row Height... Define a precise height (in pixels) for a row in the selected Table in your 

active web page. 
 
Table Properties...   View the properties of the selected table in the active web page. 
 
Table HTML...   View the source code for the HTML table that you have created. 
 
Cell Properties...   View the properties for the selected cell in the table. 
 
Cell HTML...   View the HTML code that defines a particular cell in your table. 
 
 

TUTORIAL: 
Working with tables in BlueVoda 
CLICK HERE for Video Tutorial 
 
This tutorial will show you how to work with tables in BlueVoda. Tables are very useful for aligning text 
and images. 
 
To get started, click the Table icon in the toolbar. 
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The Insert Table window opens up. Here you can set the number of rows and columns, as well as 
border, cell spacing and cell padding attributes. 
 
Once you have created your table, as with all other elements you can drag the table anywhere on the 
page. 
 
Once you have placed your table, you can Double-Click the table to open the “Table Properties” 
dialogue window – Here you can make any changes you would like to make to your table and when you 
are done, click the [ OK ] button to apply your changes to the table that you have created and to return 
to the work-space. 
 
If you wish to set any specific attributes to any individual cells, click the cell and open the Cell Properties 
dialogue box by using the top menu and selecting Table > Cell Properties 
 
To change the background color of the cell you have selected, for example, open the Cell Properties 
window as described above and in the Background section, use the “Color:” drop-down menu to make 
your selection. 
 
When you are done editing the properties for the cell you have selected, click the [ OK ] button to apply 
the changes you have made and to return to the work-space. 
 
You can also insert a new row or column. First select a cell relative to the new row or column that you 
would like to create. In this example, we'll add a column to the right of the cell that we've selected. To 
do this, use the top-menu and select: Table > Insert Rows or Columns 
 
Select whether you would like to add a Column or Row, specify the number of columns or rows that you 
would like to add and whether the Rows or Columns should be added to the left, right, above or below 
the cell that you've selected. 
 
Finally, you can re-size the table simply by grabbing any of the external handles and dragging your 
mouse. 
 
That's it! You are now able to work with Tables in BlueVoda. 
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BlueVoda's Layout menu 
 
BlueVoda’s Layout menu gives you full control over the layout of your 
web page and the positioning of ALL elements within it. 
 
Align 
 

Left Align your element to the left of its containing 
element 

 
Right Align your element to the right of its containing 

element 
 

Top Align your element to the top of its containing 
element 

 
Bottom Align your element to the bottom of its containing 

element 
 

Horiz. Center Align your element horizontally in the center of its containing element 
 

Vert.Center Align your element vertically in the center of its containing element 
 
Space Evenly 
 

Across  Make the spacing between your selected elements equal across your web page 
 

Down  Make the spacing between your selected elements equal down your web page 
 
Center in Page 
 

Vertical Vertically align your selected element in the very center of your active web page 
 

Horizontal Horizontally align your selected element in the very center of your active web 
page 

 
Make Same Size 
 

Width  Gives all selected elements in your website the same width 
 

Height  Gives all selected elements in your website the same height 
 

Both Gives all selected elements in your active web page the same size and area i.e. 
width and height 
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Arrange 
 

Move to Front  Moves your selected website element to the front of any other website 
elements that occupy the same space 

 
Move to Back  Moves your selected website element to the back of any other website 

elements that occupy the same space 
 

Move Forward  Moves your selected website element forwards ( by one increment ) of 
any other website elements that occupy the same space 

 
Move Back  Moves your selected website element to the front of any other website 

elements that occupy the same space 
 
Group Connect your selected elements together so that they’re position 

relative to one another remains constant  
 
Ungroup Disconnect your selected elements so that they can once again be 

manipulated independently of one another 
 
Set Tab order    
 
Guide Settings... Open the dialog that will allow you to configure the properties of your 

ruler guides (i.e. color, width, etc.) 
 
Ruler Guides... 
 

Add Horizontal User Guide Add a horizontal guide at a location of your choice. 
 

Add Vertical User Guide Add a vertical guide at a location of your choice. 
 

Format Ruler Guides... Edit/ Change the ruler guides that you have added to your web 
page. 

 
Clear All Ruler Guides Removes all ruler guides that you have set up for your active 

web page. 
 
 

TUTORIAL: 
Using guide settings in BlueVoda 
CLICK HERE for Video Tutorial 
 
Guide settings in BlueVoda are useful because you may find it much easier to align elements in your 
web page with the guide settings turned on. 
 
From the menu bar, pick Layout > Guide Setting... 
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Click Show Grid to enable the display of the grid. 
 
You can configure the grid as you like and if you turn on Snap to guides, elements will align themselves 
to the grid. 
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BlueVoda's Tools menu 
 
The BlueVoda Tools menu provides you many tools to facilitate your 
website. It gives you information and assistance with the content of 
your pages and also provides tools to assist the publishing of your 
website and its promotion. 
 
Spelling 
 

Spelling... 
 

Spelling Options... Opens the Spell Checker Options 
dialog. Here you can manage your 
options and the dictionaries that can be used for spelling 

 
Auto Correct Options... Opens the AutoCorrect dialog. Here you can manage how BlueVoda 

automatically corrects typographic errors that you make and also lets 
you define what typographical errors you do not want BlueVoda to 
automatically correct. Finally you can also define what additional 
corrections you want BlueVoda to automatically make to your work. 

 
Asset Manager... Opens the Asset Manager window, which shows you every element that 

you have added to your active web page. 
 
Page Weight... Opens the Page Weight dialog, which shows you the file size of each of 

your open windows, the total file size of your open pages combined and 
lets you see the estimated download time of your website for a given 
Connection speed (e.g. 56k). 

 
Sitemap... Creates an XML Sitemap to ease the crawling of your website pages by 

the Googlebot and the other Search Engine Crawlers and Spiders 
 
Verify Links...   Verify your links here 
 
FTP Manager... Launches the BlueFTP File Transfer Protocol client software to facilitate 

the upload of website files to your VodaHost server 
 
Options... Opens the Options dialog where you can configure all the general 

options for the BlueVoda website builder. 
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TUTORIAL: 
Using BlueFTP in BlueVoda 
CLICK HERE for Video Tutorial 
 
Here, we'll show you how to use BlueFTP in BlueVoda 
 
Select: Tools > FTP Manager... 
 
Your FTP Manager shows your local files on the left side... ... and the remote files on the right side. 
 
When you first open the FTP Manager you are not currently connected to the server. Let's go ahead and 
connect to it now. 
 
Click the [ Connect ] button to open the Connect dialogue box 
 
Using the Server IP: drop-down menu, ensure that your server IP is selected. 
 
Enter your username and password to login 
 
Click the [ Connect ] button 
 
When you first connect to the server, by default you are in your root directory (public_html) 
 
Let’s create a new folder 
 
Right click and select New Folder. This opens up the Create New Folder dialogue. Here, you give the new 
folder a name... e.g. “zipfiles” 
 
Click the [ OK ] button. 
 
This will create a folder called zipfiles on the right side. 
 
So far, so good. We would like to upload a file to this new folder, so let's open the folder by double-
clicking on it. 
 
Now we need to locate the file that we wish to upload from our local files. 
 
In our local files, in this example, we see that we need to go up one directory in order to locate our file. 
We do this by clicking the Up icon. Be sure you have the proper side selected before clicking the Up icon. 
 
To upload a file, left click it and drag it over to the remote directory. 
 
Success! - The file has been successfully uploaded. Similarly, to download, simply drag from the remote 
directory to the local one. 
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Important: Your FTP Manager is not meant for uploading your BlueVoda site files. On your 
computer, they are in an encrypted .bvp format. In order to display properly on the 
Internet, they must be published via BlueVoda 

 
Your FTP Manager is meant for uploading non site files. For example, you may wish to 
upload a zip file (like we did in this example) so that your site visitors can download it 
from your site. Other examples of file types you can upload are .pdf, .doc, etc. 

 
And of course, when you're done, don't forget to disconnect … You can do this by clicking the [ 
Disconnect ] button. 
 
You now know how to use BlueFTP, your built-in FTP Manager in BlueVoda. 
 
 

TUTORIAL: 
BlueVoda Using Different Languages 
 
To use other languages in BlueVoda besides English, please follow the below instructions: 
 

1. Open up BlueVoda 
 

2. Select Tools from the Menubar 
 

3. In Tools select Options 
 

4. The Options dialog box will appear 
 

5. Tick Enable UNICODE 
 

6. Press [ OK ] 
 
 

TUTORIAL: 
BlueVoda SiteMap Generator 
 
A XML Sitemap allows search engines (Google, yahoo, etc...) to thoroughly index your website. BlueVoda 
10+ has a Built in Sitemap Generator. 
 
Please follow the below steps to create your website's Sitemap. 
 

1. Open up BlueVoda and go Tools > Sitemap 
 

2. The Sitemap dialog box will launch... 
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3. Enter your websites Domain name and hit "Start Crawler" 
 

4. Go make yourself a cup of coffee and wait for the Crawler to do its job. 
 

5. When the Crawler is done, hit "Publish Sitemap" to upload your Sitemap to your public_html 
folder. 
 

6. The crawler will upload a file called sitemap.xml to your VodaHost account. 
 

7. After your sitemap is complete, submit it to Google. 
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BlueVoda's Window Menu 
 
The BlueVoda Window Menu gives you control of the layout of your 
web pages that you are working on with BlueVoda. 
 
New Window  Opens up a new window for the active document 
 
Cascade  Arranges your windows so that they overlap 
 
Tile   Arranges your open windows as non-overlapping tiles 
 
Arrange Icons  Arranges icons at the bottom of your windows 
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BlueVoda's Help menu 
 
The BlueVoda Help menu gives you access to many resources as you build 
your website. From access to video tutorials and templates for your 
website to access to customer support as well as the VodaTalk community 
forum. 
 
Video Tutorials Delivers you to a page with many helpful video 

tutorials on the BlueVoda website builder using 
your default web browser. There are many tutorials 
here that cover all subjects from the planning of your website to its construction 
to its promotion. 

 
Templates  Using your default web browser, selecting this option delivers you to a page on 

the VodaHost site where you can download templates and other elements to 
help you customize your website. 

 
Community Forum Delivers you to the VodaTalk community forum using your default web browser. 

Here you can ask any and all questions regarding the design, upkeep and 
promotion of your website. Always ask your questions here first! 

 
Customer Support  Takes you to the VodaHost web hosting help center using your default web 

browser. 
 
Control Panel Takes you to your WHM cPanel login page, Web Mail login page or VodaHost 

Billing login page for your VodaHost web hosting account using your default 
web browser. Here you should enter your log-in credentials regarding the 
section that you wish to log-in to and click [Login] 

 
About BlueVoda... Displays information about your BlueVoda product including program 

information, version number and copyright information. 
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FINAL TUTORIAL: 
How to Create a Download 
 
Sometimes you want your website visitor to be able to download a file from your website, such as a 
.pdf, MP3, .exe, .zip, etc... This is very easy to do, please follow the below instructions... 
 

1. When creating a file that is designed to be downloaded, it is extremely important that you keep 
the file name as short as possible and do not use any capital letters, spaces or punctuation 
marks. 
 

2. Upload the file you want your visitor to be able to download into your public_html folder. You 
can upload via FTP or you can use the upload feature in your File Manager in your control panel. 
 
OK... 
 
Next... 
 
Let's look at the example of the domain name www.BlueVoda.com, we want to provide the 
BlueVoda Website Builder as a download to our visitors... 
 
a) We created a file zip file called bv.zip 
 
b) We uploaded bv.zip to our public_html folder 
 
That’s it! 

 
The download link is www.BlueVoda.com/bv.zip; anybody who clicks this link will download the 
BlueVoda website builder. 
 
Let's Recap... 
 
Your Doman Name + File = Downloadable link 
 
BlueVoda.com is the domain name 
 
bv.zip is the file 
 
We separate the two with a slash / 
 
And we get the downloadable link BlueVoda.com/bv.zip 
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THE SECRETS TO PROMOTING 
YOUR WEBSITE ONLINE 

What your competition doesn't want you to know 
 
Now that you have finished building your website, give it the power to climb right to the top of the 
Search Engines with our free report: “The Secrets to Promoting your Website Online” 
 
In “The Secrets to Promoting Your Website Online”, you will learn the secrets of the marketing and 
promotion potential hidden within, such as:  

 
• Selecting Your Domain Name 
• Correct The Set-Up Your Website 
• Search Engine Optimization (S.E.O.) 
• Building Your Links 
• Social Bookmarking and networking 
• Google Webmaster Tools 
• Setting-Up Your Auto-Responder 
• Plus much, much more... 

 
So, make yourself up a pot of coffee ... What 
you’re about to download and read will blow 
you away!!! 
 

Special Bonus 
 
Click Here to learn how to make serious $$$’s 
by simply sharing “The Secrets To Promoting 
Your Website Online” with your friends and 
colleagues. 
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